## Table of Contents

**INTRODUCTION TO LINUX MINT** ......................................................................................... 4

- History ............................................................................................................................... 4
- Purpose ............................................................................................................................... 4
- Version Numbers and Codenames .................................................................................... 5
- Editions ............................................................................................................................... 6
- Where to Find Help .......................................................................................................... 6

**INSTALLATION OF LINUX MINT** .................................................................................... 8

- Download the ISO ............................................................................................................. 8
  - Via Torrent ..................................................................................................................... 8
  - Install a Torrent client ................................................................................................. 9
- Via a Download Mirror .................................................................................................... 9
- Read the Release Notes ................................................................................................... 9
- Check the MD5 .................................................................................................................. 10
- Burn the ISO to DVD ...................................................................................................... 11
- Boot the LiveDVD .......................................................................................................... 12
- Install Linux Mint on Your Hard Drive ......................................................................... 13
- The Boot Sequence ......................................................................................................... 19

**INTRODUCTION TO THE LINUX MINT DESKTOP** ......................................................... 20

- The Welcome Screen ...................................................................................................... 20
- The MATE Desktop ......................................................................................................... 20
  - Desktop Settings ......................................................................................................... 21
  - The Menu .................................................................................................................... 22
  - The “Places” menu ...................................................................................................... 22
  - The “System” menu ..................................................................................................... 25
  - The “Applications” menu ............................................................................................ 29
  - The “Search” field ....................................................................................................... 31
  - Define your favorite applications ............................................................................... 32
  - Make your own shortcuts ............................................................................................ 32
  - Launch applications automatically when you log in .................................................. 32
  - Change the appearance of the menu ......................................................................... 32
  - Activate the Recent plug-in ....................................................................................... 33
  - Restore the default settings ....................................................................................... 34
  - Replace the menu with the default MATE menu ....................................................... 34

**SOFTWARE MANAGEMENT** .......................................................................................... 35

- Package Management in Linux Mint .............................................................................. 35
  - The Software Manager ............................................................................................... 40
  - The Menu .................................................................................................................... 40
  - Synaptic & APT .......................................................................................................... 40
  - Remove Applications .................................................................................................. 41
FROM THE MENU......................................................................................................................41
USING APT..................................................................................................................................42
SYNAPTIC.....................................................................................................................................42
UPDATE YOUR SYSTEM AND YOUR APPLICATIONS.................................................................43
USING THE UPDATE MANAGER.................................................................................................43

TIPS AND TRICKS..........................................................................................................................48

COPY AND PASTE WITH THE MOUSE......................................................................................48
TAKE NOTES WITH TOMBOY.......................................................................................................49
CONCLUSION..............................................................................................................................50
Introduction to Linux Mint

Linux Mint is a computer operating system designed to work on most modern systems, including typical x86 and x64 PCs.

Linux Mint can be thought of as filling the same role as Microsoft's Windows, Apple's Mac OS, and the free BSD OS. Linux Mint is also designed to work in conjunction with other operating systems (including those listed above), and can automatically set up a “dual boot” or “multi-boot” environment (where the user is prompted as to which operating system to start at each boot-up) during its installation.

Linux Mint is a great operating system for individuals and for companies.

History

Linux Mint is a very modern operating system; Its development started in 2006. It is, however, built upon very mature and proven software layers, including the Linux kernel, the GNU tools and the MATE desktop. It also relies on the Ubuntu and Debian projects and uses their systems as a base.

The Linux Mint project focuses on making the desktop more usable and more efficient for everyday tasks performed by regular users. Underneath the desktop the operating system also provides a huge collection of available software and a very well integrated set of services.

Linux Mint saw a rapid rise in popularity and more and more people use it every day.

Purpose

The purpose of Linux Mint is to provide a desktop operating system that home users and companies can use at no cost and which is as efficient, easy to use, and elegant as possible.

One of the ambitions of the Linux Mint project is to become the best operating system available by making it easy for people to get to use advanced technologies, rather than by simplifying them (and thereby reducing their capabilities), or by copying the approaches taken by other developers.

The goal is to develop our own idea of the ideal desktop. We think that it is best to make the most out of the modern technologies that exist under Linux and make it easy for everybody to use its most advanced features.
Version numbers and codenames

Version numbers and codenames follow a unique logic in Linux Mint:

- Codenames provide a way to refer to versions of Linux Mint that is more familiar than using a version number.

- Since version 5, Linux Mint has followed a 6 months release cycle and uses a simplified version scheme. The version number simply gets incremented every 6 months for major releases.

- If revisions are made to a particular release (a bit like Service Packs in Windows) its version number gets a minor revision increment. For instance “3” becomes “3.1”.

- Since version 17.1 updates are based upon the latest Long Term Support version. So the LTS version 17 is followed by 3 minor versions before the next major. This gives all these releases a Long Term Support status.

- Codenames in Linux Mint are always female names ending with “a”. They follow the alphabetical order and the first letter of the codename corresponds to the index of the version number in the alphabet.

So far Linux Mint has used the following codenames:

<table>
<thead>
<tr>
<th>Version</th>
<th>Codename</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Ada</td>
</tr>
<tr>
<td>2.0</td>
<td>Barbara</td>
</tr>
<tr>
<td>2.1</td>
<td>Bea</td>
</tr>
<tr>
<td>2.2</td>
<td>Bianca</td>
</tr>
<tr>
<td>3.0</td>
<td>Cassandra</td>
</tr>
<tr>
<td>3.1</td>
<td>Celena</td>
</tr>
<tr>
<td>4.0</td>
<td>Daryna</td>
</tr>
<tr>
<td>5</td>
<td>Elyssa</td>
</tr>
<tr>
<td>6</td>
<td>Felicia</td>
</tr>
<tr>
<td>7</td>
<td>Gloria</td>
</tr>
<tr>
<td>8</td>
<td>Helena</td>
</tr>
<tr>
<td>9</td>
<td>Isadora</td>
</tr>
<tr>
<td>10</td>
<td>Julia</td>
</tr>
<tr>
<td>11</td>
<td>Katya</td>
</tr>
</tbody>
</table>
Editions

An Edition is a release of Linux Mint which is customized to address a certain set of needs. This guide covers the MATE Edition. Here are some of the most popular editions:

- MATE Edition (uses a MATE desktop)
- Cinnamon Edition (uses a Cinnamon desktop)
- KDE Edition (uses a KDE desktop)
- Xfce Edition (uses an Xfce desktop)

If you don’t know which edition to use, you should choose the MATE Edition.

Note: If you intend to redistribute or to make commercial use of Linux Mint in the USA or in Japan and if you’re not sure about patent legislation you should use the “No Codecs” installation images.

Where to find help

The Linux Mint community is very helpful and very active. If you have questions or a problem related to Linux Mint, you should be able to get help from other users online.

First, make sure to register with the “Linux Mint Forums”. This is the very first place where you can find help: [http://www.linuxmint.com/forum](http://www.linuxmint.com/forum).

If you want to chat with other users you can connect to the IRC chat room. Under Linux Mint simply launch “HexChat” from the menu. If you’re using another operating system or another IRC client make sure to connect to the “irc.spotchat.org” server and to join the channels “#linuxmint-help” and “#linuxmint-chat”.

Linux Mint uses Ubuntu repositories (more on what this means later) and is fully compatible with it so most of the resources, articles, tutorials, and software made for
Ubuntu also work for Linux Mint. If you can’t find help on a specific subject, make sure to search on the same subject for Ubuntu.

Note: Ubuntu is another operating system based on GNU/Linux.

Note: A repository is an online service by which software is stored and made available for the operating system to install and update from. Most operating systems based on GNU/Linux use repositories and connect to them via HTTP or FTP to install and upgrade their software.
Installation of Linux Mint

You can download the Linux Mint operating system for free. It comes as an ISO file which you need to burn to a blank DVD. The liveDVD is then bootable and provides a fully-functional operating system which you can try without affecting your PC. In layman's terms, when you put Linux Mint on a DVD and place it into your computer, you can try it out while leaving your current system intact.

Note: It is also possible to write the ISO image to a USB stick or other memory device and boot from that, or to boot from the ISO image on the hard drive, but these options are somewhat more advanced and the method presented here is recommended. For help with alternative methods of installing and running Linux Mint, please visit the forums.

If you like what you see when running the liveDVD you can decide to install the system to your hard drive. All the necessary tools (partitioning and installation tools) are present on the DVD.

Download the ISO

Note: If you don't have a broadband connection, or if your Internet access is too slow you can order the DVD from this web site: http://www.osdisc.com

Otherwise, you can visit the Linux Mint download page here: http://www.linuxmint.com/download.php

Then choose the edition you're interested in.

From this page, you should be able to find:

- an MD5 signature
- a torrent link
- a list of download mirrors

The file you need to download is an ISO file. There are two ways to download this file, by torrent (a Peer to Peer protocol) or via a download mirror (HTTP or FTP protocol). Once your download is finished, you can ensure your ISO file isn't corrupted by checking its signature with the MD5.

Via Torrent

Torrent is a Peer to Peer (P2P) protocol. Basically, instead of downloading from a central location, a torrent lets you download the ISO file in parts from different people across the Internet.
The more people who download the ISO file, the faster the download speed gets. This is the preferred and recommended way to download Linux Mint.

**Install a Torrent client**
You need a piece of software called a “torrent client” in order to download files via torrent.

If you run Linux, you can install “Transmission”. If you run Linux Mint, Transmission is already installed.

If you run Windows, you can use µTorrent.

**Download the Torrent file**
The next step is to follow the torrent link from the Linux Mint website and to download the .torrent file. This file is very small. After it downloads, you should open it with your torrent client.

The torrent client will probably ask you where you want to save the ISO. Select a destination and then wait for the download to complete.

For more information about the torrent protocol, visit: [http://en.wikipedia.org/wiki/BitTorrent](http://en.wikipedia.org/wiki/BitTorrent)

**Via a download mirror**
If you can’t, or do not choose to use the torrent protocol, then look at the list of download mirrors and pick one of them. They’ll provide a link to the ISO file itself which you can just click to start the download.

Note: Remember that bandwidth is limited though and the more people download from a mirror, the slower the download speed gets for everybody who is downloading from that mirror. Furthermore, if for some reason the download should be interrupted, it may be corrupted and the download may have to be restarted. For these reasons it might be worthwhile using a download manager, like for Linux, or for Windows, if taking this route.

**Read the Release Notes**

Your download is probably going to last quite some time, so now would be the perfect moment for you to get familiar with the new features coming with the release you’re currently downloading.

The release notes are featured on the Linux Mint web page and answer the following questions:

- What are the new features delivered in this release?
- What are the known problems of this release?
• How do I upgrade from the previous release?

They also contain screenshots of the latest release. Of course, you could find out about most features highlighted in the release notes by simply using the operating system, but you might miss a few things, so it is most reliable to read the release notes.

The link to the release notes for Linux Mint 17.3 Rosa is:

http://www.linuxmint.com/rel_rosa_mate.php

**Check the MD5**

You’ve read the release notes, you just can’t wait to play with the new features or try Linux Mint, and your download just finished successfully. You’re ready to burn a DVD and to boot on it… but hey! Wait for a second!

If that DVD is faulty you will experience weird bugs and will have a lot of trouble finding help. The two most common reasons for a DVD to be faulty are:

• An issue with the download causing problems in your ISO file
• An error during the burn process that alters the contents of your burned liveDVD

The MD5 signature, which is present on the download page, provides a quick way for you to make sure that your ISO file is exactly like it should be. So, let’s check the ISO file you just downloaded before we burn it and save ourselves from a lot of potential problems.

If you run any version of Linux you probably already have the md5sum program installed. Open a terminal and “cd” to the directory where your ISO file is (for instance, if “linuxmint.iso” is on the Desktop), open a terminal and type:

```
cd ~/Desktop
md5sum linuxmint.iso
```

This command should output a series of numbers and letters which comprise the MD5 sum, or signature, of your ISO file. By design, any small change to the ISO file will cause this signature to be significantly different, allowing us to verify that the file is exactly as it should be.

Compare that signature with the one on the download page of the Linux Mint website. If the two signatures are the same, then you know your ISO file is exactly the same as the original and you can now get ready to burn it on DVD

If you happen to run Windows, chances are you don’t have md5sum installed. You can get it from here: http://www.etree.org/md5com.html
Place the ISO file and the md5sum.exe in the same place (let’s say in C:\) and run “cmd.exe”. In the command line environment, type the following commands:

```
C:
  cd 
  md5sum linuxmint.iso
```

Then compare the signature to the one present on the website.

**Burn the ISO to DVD**

Now that you have checked the ISO file with MD5, you are ready to burn it to a DVD.

Get a blank DVD-R (a DVD-RW should work as well, but this type of media is known to have compatibility issues) and your favorite marker and label the DVD. Although labeling your DVDs sounds trivial, you should be sure to do so, as you can easily end up with 20 unlabeled and unidentifiable discs on your desk. :)

Insert the blank DVD-R in the drive and get ready to burn the ISO.

If you’re running Linux with MATE right-click on the ISO file and select “Write to Disc”.

If you’re running Linux with KDE, launch K3B and in the “Tools” menu choose “Write ISO Image”.

If you're running Linux and would like to use the terminal, from the directory you have downloaded the image to:

```
cdrecord -v -dao dev=1,0,0 linuxmint.iso
```

Replacing the numbers after dev= with the appropriate device number for your disc drive and using the proper iso-name. You can run:

```
cdrecord -scanbus
```

to find the right device. You may need to be root to run these commands.

If you’re running Windows you can use a program like InfraRecorder: [http://infrarecorder.org](http://infrarecorder.org)

*Note: Make sure to burn the ISO image to disk, and not to write the ISO file to the disk. A very common mistake, especially for people using Nero, is to actually burn the ISO file on the disk as a data file. The ISO file is an image of a disk so it needs to be burnt not as a file which will appear on the disk, but as an ISO image which will be decompressed and whose content will be burnt onto the disc. After burning the DVD you shouldn't see the ISO file within the disc, but rather folders like “casper” or “isolinux”. Most burning software has a special option for this.*
Boot the LiveDVD

Place the DVD in the drive and restart the computer. You should now see the following screen:

Note: If you don’t see this screen and your PC boots as usual it’s probably because your BIOS is not set to boot on DVD. Restart the computer and press F1, F2, Delete, or Escape (or whatever key lets you enter the BIOS configuration) and change your BIOS settings to tell your computer to boot from its DVD drive. You might also need to disable secure boot and (u)efi and possibly change the bootorder.
Install Linux Mint on your Hard Drive

From the first screen choose the default “Start Linux Mint” option and press Enter. After a little while the live system should be ready and you should see the desktop. At this stage Linux Mint is not installed on your computer, it’s simply running from the DVD. The system you have in front of you is, however, almost exactly the same as the one you will have on your computer after the installation is finished.

Have fun with it and see if you like it. Bear in mind that when running from the DVD, Linux Mint runs significantly slower than it does when it is installed on a hard drive, since it has to read data from the DVD drive, which is a slower medium than the hard drive.

When you are ready, double-click on the “Install Linux Mint” icon located on the desktop. The Installer appears:

If you haven’t read the release notes yet, and you have an Internet connection, then this is an ideal opportunity to review them; simply click on the underlined link visible when online. It is highly recommended that users read the release notes prior to installation in order to advise themselves of new features, as well as any issues that might affect their particular hardware configuration.

Select your language and press the “Continue” button.
In the next screen, make sure you're connected to a power source (if you're using a laptop), the Internet and that you have the recommended amount of disk space. Then press the “Continue” button.

In the next screen you can assign your entire hard drive to Linux Mint or install it alongside other operating systems. Alternatively, you can also define and assign the partitions manually.

- If you choose to use the entire disk, its content will be erased and Linux Mint will be installed as the only operating system on your computer.
- If you choose to install it alongside other operating systems, the installer will use the free space available on other partitions to create a new one for Linux Mint.
You will be asked how much space you want to allocate to it. The installer will then shrink a partition and take care of everything for you. Post-installation your computer will have a boot screen from which you'll be able to boot all your operating systems.

- If you choose to specify partitions manually, a partition editor will appear, giving you full control over the partitioning of your hard drive. This is recommended only to advanced users who understand how partitioning works under Linux. Note that Linux Mint requires a partition of at least 8.8 GB and that the recommended size for a swap partition is 1.5 times the amount of RAM available on the computer.

Choose the appropriate option and click on the “Continue” or “Install Now” button.

If you entered “Continue” in the last screen then the next screen gives you some more options. In the screen printed above you can resize the new partition depending on the space available in the other OS. When ready press the “Install Now” button to start the installation.

At this stage, the installation is going on in the background and the installer asks you setup questions:
Choose your location on the map by clicking on the city which is the nearest to you. The purpose of this step is to identify your time zone. Make sure the “Current time” appears correctly and click the “Continue” button.

*Note: Sometimes the installer doesn't properly handle Summer/Winter time adjustments, so even by selecting the proper city you might see a difference of an hour or so with the correct time. Simply ignore this at this stage and remember to make sure that the time is correct after you reboot in your newly installed Linux Mint desktop.*
Select your keyboard layout. If you are not sure about exactly which layout matches the keyboard you have, click on the text field at the bottom of the screen and start typing with your keyboard. Make sure the keys you press match the characters that appear in the text field in order to ensure you have selected the right keyboard layout. Some layouts only differ with respect to accents, numbers and punctuation signs, so make sure to test these as well.

When you’re ready click the “Continue” button.

Enter your real name and a username and password. Every time you’ll use Linux Mint you’ll use your account with this username and password. Once Linux Mint is installed you’ll be able to define other accounts if other people are to use this computer. Also give your computer a name. This name will be used by your computer on the network or in various places of the system. If you’ve never really thought about naming your computers, then now is the time. People commonly pick flower (dahlia, rose, tulip) or planet (mars, jupiter, pluto) names for the computers on their network. It’s entirely up to you what you want to use, but make sure to pick a name you like and that you will easily remember.

*Note: Capital letters, spaces and special characters are not permitted in the username or in the name of the computer.*

If you’re the only one using the computer and you want to bypass the login screen, check the option “Log in automatically”.
When you’re ready click on the “Continue” button.

The installer might detect other operating systems on your computer and ask you if you want to migrate some personal information. Typically this allows you to migrate bookmarks, contacts, favorites and other sorts of personal information from other operating systems installed on your hard disk drive into the newly installed Linux Mint.

When you’re ready click on the “Continue” button.
The installation should take between 10 and 15 minutes.

*Note: The installer will download packages from the Internet to support the language you’ve selected. Your computer needs to be connected to the Internet for this to work. Otherwise just “skip” that step and you’ll be able to add support for your language after the installation is finished and you’ve rebooted into your new system.*

Once the installation is done click the “Restart Now” button and the liveDVD or LiveUSB environment will shut down.

When prompted, remove the DVD from the drive and press Enter.

Your PC is now ready to boot Linux Mint from the hard drive.

**The Boot sequence**

Upon reboot, if you have more than one operating system installed, you should see a “boot menu”.

Once Linux Mint is finished loading you should see a new screen inviting you to enter your username and password. This screen is the “MDM Login Manager” and is commonly called “MDM”. Enter the password you chose during the installation.

*Note: By default, your “root” password is the same as the password you chose during the installation. If you do not know what this means, then don't worry about it.*
Introduction to the Linux Mint Desktop

This section of the guide will focus on the technologies and the tools that are specific to Linux Mint and provide information on some of the applications and technologies included by default in the MATE Edition.

The Welcome Screen

The first time you start your newly installed Mate desktop (and every other time until you choose to uncheck the checkbox on the bottom) you'll see the Welcome Screen. You can also find this screen when scrolling to the bottom of the Preferences menu or by starting to type “Wel” in the Search-bar.

![Welcome Screen](image)

Do take a look at this screen, it has a lot of interesting links!! You can find a link to the User guide there (yeah I know, you're already reading it). But also you can put the information of your machine in the Hardware database. Or you can ask questions in the Forums (or answer them of course). And Important information is Important too!

The MATE Desktop

The “desktop” is the component of the operating system which is responsible for the elements that appear on the desktop: The Panel, the Wallpaper, the Control Center, the menus…etc.
The MATE Edition of Linux Mint uses the “MATE” desktop which is both intuitive and powerful.

**Desktop Settings**

“Desktop Settings” is a tool developed specially for Linux Mint which allows you to rapidly configure the aspects of your MATE Desktop that you will use the most.

Launch it by clicking on “Menu” (in the bottom-left corner of your screen), then select “Preferences” and click on “Desktop Settings”.

![Desktop Settings](image)
The Menu

Linux Mint comes with is a unique menu. This menu was initially inspired by the “Slab” menu developed by SUSE but differs from it in many ways.

Linux Mint also comes with the default MATE menu which you can activate to replace the Linux Mint Menu, which we’ll learn how to do later on. The Linux Mint Menu is, however, worth learning. Although it is very different from what you might be used to, you’ll probably love it once you’ve gotten used to it.

To open the menu click on the “Menu” button at the bottom-left corner of your screen or press CTRL+SUPER_L (“Super_L” is the left Windows key on your keyboard).

The “Places” menu

![Places menu](image)

On the top left corner of the menu you can see a section called “Places” which provides five buttons. These buttons give you quick access to the most important places within your MATE Desktop.
The “Computer” Place shows you the storage volumes present in your computer. If your partitions are already mounted and “Desktop Settings” is set to show “Mounted Volumes” on the desktop, then you probably don’t need to access this Place very often. However, if you choose not to show the mounted volumes on your desktop, or if you need to mount a partition which is not mounted by default, this Place can prove very useful.
In contrast, the “Home” Place is one of the menu buttons you’ll probably use the most. If you’ve used MATE before, you’re probably used to clicking on the “Home” icon placed on the desktop. When windows are opened and when the desktop is not completely visible, the menu can prove useful by providing you with a way to quickly access your “Home”.

- Your “Home” folder exists to give you a place to put all of your personal data.
- The “Desktop” folder corresponds to what is shown on your desktop, so placing a file here will also place it on your desktop. The same effect can be achieved by simply dragging the file onto the desktop.
- The “Browse Network” Place simply shows you the other computers, shared services, domains, and workgroups present on your network.
- The “Trash” Place is where files end up after you delete them.

When you right click on a file you can either “Move to Trash” or “Delete”. If you choose to “Delete”, the file will be permanently deleted and you normally won’t be able to recover it. If you choose “Move to Trash” it will be moved to the “Trash” Place, which is accessible from the menu. From there you will be able to drag and drop it somewhere else if you want to restore it, permanently delete one or more files, or select “Empty Trash” if you want to permanently delete all items from the Trash.
The “System” menu

There are a number of system-choices in the menu. These provide quick access to important features of the system. Often you need to enter your password so unauthorized use of these options is not possible.

![Software Manager](image)

The “Software Manager” button launches the Linux Mint Software Manager. This program is the recommended way to install software in Linux Mint. We will talk more about this feature later on; for now, let’s explore the other options.
The “Package Manager” button launches an application called “Synaptic”. The purpose of this application is to manage the packages that are installed on your computer and the packages that are available in the repositories. If this doesn’t make much sense to you yet, don’t worry, we will talk about packages and how they work in greater detail later on.
The “Control Center” button launches the MATE Control Center. This application lets you configure every aspect of the MATE Desktop and of the computer in general. We will go through each item within this Control Center at a later time.
The “Terminal” button launches an application called “Terminal” which lets you enter commands directly using the keyboard. If you’re used to Microsoft Windows you may think that this is old hat, because in Windows the command line hasn't progressed much further than the “DOS prompt” and is hidden away in an accessories menu. One of the ways in which Linux systems differ from Windows systems is that the terminal is quite important in Linux, as it is often used as a way of getting more direct control over one’s computer. We’d probably agree that the Terminal isn’t the most visually appealing application included in Linux Mint, but it is worth knowing that it is by far the most powerful, and once learned it’s actually not very hard to use.

In fact, it is worthwhile understanding that every command that you execute using a graphical desktop environment goes through the Terminal. When you click on an icon on the menu, for example, you are instructing MATE to pass a textual instruction to the Terminal. As an instructional exercise, if you open “Main Menu” from the “Look and Feel” section of “Control Center” (see above), and navigate to any of the application menus, pick an application, and click on the properties button, you will see in the “Command” field the text command that is passed to the system when you click on that application's entry in the menu. In other words, you have already been using the Terminal for some time, perhaps without realizing it. All that was different was that, instead of you typing out the commands, your desktop (MATE) was doing it for you (which is a good thing because nobody wants to remember hundreds of application names all the time).

Sooner or later, though, you will probably have be in a situation which causes you to use the Terminal directly, either to access commands that are not available through any GUI, or to get a job done more efficiently. Yes, you read that right! It can be more efficient to type a single command, for certain tasks, than to open up lots of windows to achieve the same thing. The more you use it, the more you’ll come to actually like it. Remember
how you didn’t like certain things when you were a kid and how you couldn’t do without them now? Terminal is one of these things. In a few weeks, you’ll be completely addicted to it. You’ll begin to feel in complete control of your computer. There will be times when you won’t even have to use the Terminal, but you will anyway, because for some tasks it’s faster, more accurate, more versatile and actually simpler to use than equivalent graphical interfaces. And anyone watching you will think you’re a complete pro.

The “Lock screen” button locks your screen; a password will be asked to unlock.

The “Logout” button launches a dialog which lets you logout or switch users.

The “Quit” button launches a dialog box which lets you choose what you want to do:

- “Suspend” saves your session to RAM and your computer goes to sleep until you press a key.
- “Hibernate” saves your session to your hard drive and your computer shuts down.
- “Restart” restarts the computer.
- “Shut Down” turns the computer off.

*Note: It is also possible to lock the screen by pressing CTRL+ALT+L.*

**The “Applications” menu**

The Linux Mint DVD is compressed and actually contains about 3GB of data. The applications that are included by default when you install Linux Mint are said to be part of the “Default Software Selection”.

Since one of the purposes of Linux Mint is to be easy to use and to work out of the box, a collection of software is included by default in order to let you achieve common/important tasks.

In the right-hand section of the menu, you can see all installed applications. They are organized by categories. The first category is called “All” and, as you probably guessed, it shows you a list of all installed applications.

The last two categories, “Preferences” and “Administration”, show you the tools and applications provided to configure and administrate Linux Mint. We’ll focus on these applications later on, as they are also present in the “Control Center”.

The 5 categories in the center provide most of the applications you’ll use on a daily basis. As you install new software, new categories might appear.
In “Accessories”, you can find the following software:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Manager</td>
<td>Create and modify an archive</td>
</tr>
<tr>
<td>Calculator</td>
<td>A calculator</td>
</tr>
<tr>
<td>Color selection dialog</td>
<td>Tool to select and copy colors</td>
</tr>
<tr>
<td>Dictionary</td>
<td>Tool to search words in online dictionary sources</td>
</tr>
<tr>
<td>Disks</td>
<td>A tool to manage your drives and media.</td>
</tr>
<tr>
<td>Document Viewer</td>
<td>View multi-page documents</td>
</tr>
<tr>
<td>Help</td>
<td>A tool that shows a suitably formatted document comparable to this document</td>
</tr>
<tr>
<td>Screen Reader</td>
<td>A tool that provides support for synthesized speech and/or refreshable braille to the graphical desktop</td>
</tr>
<tr>
<td>Search Tool</td>
<td>A tool that lets you search for files on the computer</td>
</tr>
<tr>
<td>Take Screenshot</td>
<td>A tool to take screenshots. You can also launch this with the “Print Scrn” key on your keyboard to take screenshots of the desktop, or with “ALT”+”Print Scrn” to take screenshots of the current window.</td>
</tr>
<tr>
<td>Text Editor</td>
<td>Edit text files</td>
</tr>
<tr>
<td>Tomboy Notes</td>
<td>An application to take notes</td>
</tr>
<tr>
<td>USB Image Writer</td>
<td>A simple tool to make a bootable USB stick</td>
</tr>
<tr>
<td>USB Stick Formatter</td>
<td>A tool to format a USB stick</td>
</tr>
</tbody>
</table>

In “Graphics” you can find the following software:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIMP Image Editor</td>
<td>An application that lets you modify, convert or even create pictures. The best Linux equivalent to Photoshop.</td>
</tr>
<tr>
<td>gThumb</td>
<td>An application to manage your photos</td>
</tr>
<tr>
<td>Image Viewer</td>
<td>An application to browse and rotate images</td>
</tr>
<tr>
<td>Simple Scan</td>
<td>A tool to capture images from a scanner</td>
</tr>
</tbody>
</table>

In “Internet” you can find the following software:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox Web Browser</td>
<td>A Web browser</td>
</tr>
<tr>
<td>HexChat</td>
<td>An IRC chat program. It is configured by default to automatically connect you to the Linux Mint chat room (very useful if you want to talk to other Linux Mint users).</td>
</tr>
<tr>
<td>Pidgin Internet Messenger</td>
<td>An Internet Messenger (compatible with AIM, Bonjour, Gadu-Gadu, Google-Talk, GroupWise, ICQ, IRC, MSN, MySpaceIM, QQ, SIMPLE, Sametime, XMPP, Yahoo and Zephyr)</td>
</tr>
<tr>
<td>Thunderbird Mail</td>
<td>An Email application</td>
</tr>
<tr>
<td>Transmission</td>
<td>A Torrent client.</td>
</tr>
</tbody>
</table>
In “Office” you can find the following software:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LibreOffice</td>
<td>A general starter for the office productivity suite</td>
</tr>
<tr>
<td>LibreOffice Base</td>
<td>A database application (alternative to Microsoft Access).</td>
</tr>
<tr>
<td>LibreOffice Calc</td>
<td>A spreadsheet application (alternative to Microsoft Excel and compatible with XLS)</td>
</tr>
<tr>
<td>LibreOffice Draw</td>
<td>Part of the LibreOffice suite of applications.</td>
</tr>
<tr>
<td>LibreOffice Impress</td>
<td>A presentation application to make slides (alternative to Microsoft Powerpoint and compatible with PPT)</td>
</tr>
<tr>
<td>LibreOffice Math</td>
<td>A tool to create and edit Math formulas</td>
</tr>
<tr>
<td>LibreOffice Writer</td>
<td>A word processor (alternative to Microsoft Word and compatible with DOC.)</td>
</tr>
</tbody>
</table>

In “Sound & Video” you can find the following software:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banshee</td>
<td>A music application to play online radio, stream music from the Internet and online music services and to listen to your collection of music files (alternative to iTunes). Banshee also manages podcasts, portable players and can rip CDs.</td>
</tr>
<tr>
<td>Brasero</td>
<td>A CD/DVD burning application. Brasero can also make audio CDs from multimedia files.</td>
</tr>
<tr>
<td>Sound</td>
<td>A tool to change volume and sound events</td>
</tr>
<tr>
<td>Videos</td>
<td>A multimedia application which is associated with most video and audio files (alternative to Microsoft Media Player)</td>
</tr>
<tr>
<td>VLC media player</td>
<td>A video player, notorious for being able to play most video files available on the Web.</td>
</tr>
</tbody>
</table>

The “Search” field

If you can’t remember how to find a particular application within the menu or if you want to get quicker access to it you can use the search feature. Simply click on “Menu” in the bottom-left corner of your screen and start typing the name or a description of the application you’re looking for.

As you’re typing, only the applications matching your search will stay visible within the menu.

If your search yields no results, the menu will provide “suggestions” related to the keyword you typed. For instance, if you type “opera” and if the Opera web browser isn't installed on your system, the menu will show a button to install it, or to search the software portal or the repositories for it.
Define your favorite applications

You’ll use some applications more than others, so you’ll quickly find that you want fast access to the applications that you’re using the most.

The menu lets you define “favorite” applications and keep them on a special menu for easy availability.

Right click on an application of your choice with the menu and select “Show in my favorites”. You can also drag & drop an application on the “Favorites” button which is located on the top-right corner of the menu.

Click on the “Favorites” button in the top-right corner of the menu and you should now see your favorite applications (click the button again to switch back to the complete application list).

When the favorites section of the menu is active, you can reorganize the applications. Dragging and dropping allows you to change their order, while the right click menu lets you insert spaces and separators, as well as removing items (including spaces and separators) from the menu.

Make your own shortcuts

If you don’t like the idea of having “Favorite” applications, you can simply use your panel or your desktop to achieve similar results, (namely, giving yourself quick access to your applications). Simply drag & drop the application of your choice from the menu to your panel or to your desktop.

Launch applications automatically when you log in

You can right-click on any application in the menu and select “Launch when I log in”. The application will then be launched automatically each time after you log in. This can be disabled by following the same procedure again.

Change the appearance of the menu

You can customize the menu in many ways. Right click on “Menu” and select “Preferences”.

The configuration tool for the menu appears. Here, you can modify almost every aspect of the Linux Mint menu. Most of the settings take effect immediately, but some require the menu to be restarted (this can be accomplished by right clicking the menu button and selecting “Reload Plugins”).

**Activate the Recent plug-in**

The menu comes with a plugin which is not activated by default (mostly because it makes the menu bigger). This plugin shows the 10 most recently opened documents.
To activate this plug-in, open the menu preferences and select “Show Recent Documents”.

**Restore the default settings**

If you want to revert to the default settings, right click on the menu button within the panel, choose “Remove from Panel”, then open a terminal and type:

```
mintmenu clean
```

Then right click on an empty part of the Panel and choose “Add to Panel”.

Then select “mintMenu” in the list.

**Replace the menu with the default MATE menu**

If you decide you don’t like the menu and that no matter how cool it is, you want to use the default MATE menu instead, then follow the steps below.

Right click on the menu button within the panel and choose “Remove from Panel”.

Then right click on an empty part of the Panel and choose “Add to Panel”.

Then select “Main Menu” if you want a simple MATE Menu, “Menu Bar” if you want the default MATE Menu or “mintMenu” if you change your mind and actually want to use the Linux Mint menu.
Software Management

Package Management in Linux Mint

If you have installed Linux for the first time, then you may not be familiar with the concept of organizing software into “packages”. You will soon become familiar with package management and appreciate the advantages it offers in terms of security, control and ease of use.

We have tried to make it so that all or most of your hardware was detected and drivers were installed automatically so that your computer would work out of the box. We have also tried to make it so that you could do many of the things you want to without having to look around for third party software on websites. You may have noticed that your Linux Mint installation already has a full office suite, a professional-quality image-editing solution, an IM and an IRC client, a disk burner, and several media players (as well as many other basic accessories). Relax, it's okay! You haven't stolen anything! This is what free software is all about! And the truly great thing about package management in Linux Mint and generally is that you should never need to look far and wide for extra software, even when the time comes that you do want more functionality from your Linux Mint system.

This section is intended to explain how this works and the advantages that it can bring to you. It's a bit long, but hopefully it will provide you with a good understanding of the philosophy behind package management and why it is considered a Good Thing (a phrase commonly capitalized by Linux users to mean that something is squarely in the category of good). If you're in a hurry, you can skip to the next section which will tell you how to actually use the package system.

The problems with browsing software vendors' websites and downloading and installing the software they offer are many:

- It is difficult or impossible to find out if the software has been tested to work with your operating system
- It is difficult or impossible to know how this software will interact with the other software installed on your system
- It is difficult or impossible to know if you can place your trust that software from an unknown developer software will not cause any harm, willful or negligent, to your system. Even if you know about a specific piece of software and its developer, you cannot be entirely sure that you are not downloading an executable that has been swapped out by a malicious third party for some type of malware.
Furthermore, a problem with downloading and installing multiple different programs, from multiple different developers, is that there is no manageria infrastructure. Before you say “big deal”, consider how you are going to keep all these different pieces of software up to date. If you get tired of a program and want to remove it, how do you know how to achieve that? The program in question might not have come with a removal option, and even if it did, much of the time this will fail to remove the software cleanly and completely. In a very real sense, when you ran that installer program, you gave up some of your control of your computer to a program written entirely by a complete stranger.

Finally, software which is distributed in this way is often, by virtue of necessity, “static”. This means that not only do you need to download the program itself, but also all of the data libraries that are required for it to run. Since a third-party software developer cannot know which data libraries you may already have available on your system, the only way that they can guarantee it will run on your system is by supplying all of the data libraries it needs along with the program itself. This means bigger downloads, and it means that when the time comes to update a given library, it needs to be done separately for all those programs using it, instead of just once. In summary, the distribution of static software results in the unnecessary duplication of a lot of work.

Package management in Linux Mint, and GNU/Linux operating systems in general, has been established for some time and is the preferred method for managing software as it avoids all of these issues. We've been safely and automatically installing our software since the early 1990s.

Software is first written by a developer, as you might expect, and this end of the production chain is known as “upstream”. As a user of a Linux distribution, you are referred to as being at the furthest point “downstream” (unless you're an admin, in which case your users are the furthest point downstream, but you knew that because you're an admin). Once the developer is happy with the program or the update to the program they have written, they will release the source code for it. They will also communicate in their documentation which data libraries or other programs they took advantage of when they were writing the program. They have been doing this for some time and there are standardized and venerable ways for them to do this. Note that, with a few exceptions (usually either hardware manufacturers who release drivers for Linux, like nVidia or ATI, or certain major companies like Adobe, who we can trust) they release the actual source code for the program, that is, the list of instructions in that program in a human readable form. This has a number of implications, but most importantly for this discussion it means that they are willing to have their software peer reviewed by anyone and everyone with an Internet connection. It's awfully difficult to sneak spyware into your program when you're letting everyone see what you’ve written!

The software now moves down the stream to package maintainers, who are either volunteers or paid employees working for a Linux distribution. It is their responsibility to compile the source code for the software, test it on the distribution to make sure that it works, resolve any problems that they encounter and finally package the compiled (i.e.,
machine-readable) software in a convenient format. This package contains the executable
program(s), their configuration files, and the instructions the package management
software needs to successfully install it. Note that it won't ordinarily contain any static
libraries, since it doesn't need to – the libraries are provided by other packages, and are
therefore known as shared libraries. Your package management software will know if
that a particular package requires another package to be installed first (like a shared
library), because, as you will remember, the data libraries and related packages needed
for the software to work were declared further upstream and that information is included
in the package. The instructions are sufficiently detailed that even specific versions of
other packages can be requested to ensure interoperability. The finished package is then
uploaded to a special file server, which is called a software repository.

It is from that single location that you are able to download and install the software you
need. You will know that the location is bona fide, because it is signed with a certificate
that your package manager will check. You will also know that each individual package
that you install is secure, because each package is itself signed by a GPG key, which your
package manager will also check. Your package manager will even run an MD5 sum on
each package to make sure that nothing went wrong when it was downloading, just like
we did before with the LiveDVD iso. Notice how it's doing all of this for you. You're just
sitting back, sipping a martini, and chatting in #linuxmint on xchat. The package manager
has downloaded the packages you have selected, it will follow, to the letter (computers
are fastidious in following instructions), the instructions in the package to perfectly install
your software, and all of its dependencies, in the right order. There is no space for human
error – if the package worked on the maintainer's computer, then it ought to on yours
because the package manager will follow exactly the same procedure.

When it comes time to check for software updates, your package manager will
automatically compare the software version that you have against what is available in the
repository, and do all the necessary work to keep your system running smoothly and
securely. So, if version 2.4 of BestSoft is uploaded to the repository, and you have
version 2.3, the package manager will compare those version numbers, and offer to install
the latest version, taking care, of course, of all the dependencies for the newer version of
the software.

Sounding good yet? It gets better.

Humans err where computers don't and from time to time something may go wrong in
this process. Perhaps you will, by accident, install hardware drivers for the wrong piece
of hardware and this might break something. We've all done that. Or perhaps there's a bug
or your favorite feature was removed by the program's developer for some reason. These
problems demonstrate, paradoxically, the strength and security of package management.
Because your package manager keeps fastidious records of everything it ever does, it is
able to reverse installations, cleanly and completely. It will make sure that removing one
package doesn't break any others, and you can even tell it specifically to do things like
not automatically upgrade certain packages, because you like them the way they are, or to
revert to an earlier version. Finally, the whole process is very heavily peer-reviewed.
Because you are part of a large community of Linux users, all using the same repositories to obtain their software, if anything goes wrong you can be absolutely sure there will be a big fuss about it, and that the problem will be resolved quickly! In this way, software distribution in GNU/Linux distributions is very much based on trust, from the moment the original developer displays their source code for all to see, to the open discussion on the distribution's website. You can be confident in the software you obtain, not only because of the security protocols already mentioned, but because if anything does go wrong everyone will be talking about it!

Let's look again at our list of problems and see what we have solved:

- **It is difficult or impossible to find out if the software has been tested to work with your operating system**
  - You know that the software available to you through the repository has been thoroughly tested by the package maintainer and the testing team to work with your operating system. They won't want to get it wrong, mostly on principle, but also because if they do they'll soon be getting lots of emails.

- **It is difficult or impossible to know how this software will interact with the other software installed on your system**
  - Similarly, package maintainers try their utmost to ensure that packages won't conflict with other packages offered by their distribution. Of course, they might not have every last package installed on their testing machines (in fact, usually package maintainers build their packages on clean installations to ensure that they are standard), but if a member of the user community finds out that there is a problem, they will no doubt let the distribution team know, and the problem will be fixed, or at least worked on. Unless you are a beta tester, then you are unlikely to ever see such a conflict, because that's what beta testing is for.

- **It is difficult or impossible to know if you can place your trust in the developer that their software will not cause any harm, willful or negligent, to your system**
  - Package maintainers are hardly likely to package software they know will harm people's computers (including their own)! Only software which is known and trusted will ever make it to the repository.

- **Even if you know about a specific piece of software and its developer, you cannot be entirely sure that you are not downloading an executable that has been swapped out by a malicious third party for some type of malware.**
  - In addition to the usual security measures put in place by the institutions who own the servers (usually prestigious academic or research institutions, or large companies), the repository and packages themselves are secured by certificates and GPG keys. If something's gone wrong, your package manager will tell you about it. The present author, in ten years of using Linux, has never once known anything to go wrong in this respect.

- **It is difficult to remove (all traces of) installed programs**
  - Because the package management software keeps a complete record of all of its actions, it is quite capable of reversing any steps that it took in the past,
while ensuring that removing one package will not cause any other package to fail.

- **Static packages are big and clunky**
  - Because you're using package management, you will only ever download static libraries when there is no shared alternative. If you need new shared data libraries to install a given program, your package manager will know this and install them for you automatically. You will only ever have to download a shared library once because, well, it's shared by all the programs that need it. If you end up removing the last package that needs a shared library, then the package management software will remove that too. **But**, if you decide that you do want to keep the shared object anyway, perhaps because you just know you'll need it later, then you can tell the package management software to do that, too.

- **I'm still not convinced**
  - Good! Post a message on the forums about it if you have a genuine concern about package management, or to ask about other people's experiences. It bears repeating that the package method of distribution in GNU/Linux relies on trust, so if there's a problem, we want to hear about it!

A final word. You may have been subjected to rumors to the effect that Linux isn't finished yet, or that if you use Linux then you are a beta-tester, or that Linux software is unstable. These are all half truths. “Linux” will never be “finished”, any more than any other major operating system can be considered “finished”. From the Linux kernel to the artwork on your screen, all the elements of your operating system will *always* be under some kind of development. This is because programmers are working hard to keep us up to date with the latest developments in programming and hardware technology. This does *not* mean that the software available for you to use is of bad quality. The base system at the core of Linux Mint has been under heavy development for about two decades now, and is very mature, stable, and proven. While there are definitely unstable versions of most of the software on your operating system, you won't be using them because *you're* not a beta tester. You know you're not a beta tester, because you're reading this. The software available to you on the repositories you use will *always* be stable and well tested, unless you change those repositories to the ones used by the testers (in which case congratulations, you've just become a tester). It's a bit of a no-brainer, really.

So, to summarize with an example, when you install Opera, Real Player or Google Earth in Linux Mint, these applications do not come from their original developers (Opera, Real and Google). Of course the upstream application comes from these developers, but only after they’ve been properly packaged and tested do they become available for you. So, in other words, you should never need to go and browse the Internet to look for software, as everything you need is available and already tested for you and for your system by the Linux Mint and Ubuntu teams. All you need to do is choose what you want to do.
Linux Mint will update itself automatically through a tool called the Update Manager, which will update not only the base operating system, but all the software installed on your machine as well.

It's that simple. Whew!

Some of the most popular applications that are not installed by default in Linux Mint are Opera, Skype, Acrobat Reader, Google Earth and Real Player.

**The Software Manager**

The easiest way to install software in Linux Mint is to use the Software Manager. It is built on top of the package technology we discussed earlier, but makes things easier to understand, as it allows you to install *programs* rather than packages (though, remember, it is still using the package system in the background, so it still has the same benefits).

Open the menu and select “Software Manager”.

The Software Manager lets you browse the software made available for Linux Mint. You can browse by category, search by keyword or sort the software by rating and popularity.

**The Menu**

If you know what you're looking for, you don't need to launch anything. Just start typing the application's name in the menu and have it installed from there.

For instance, to install the “gftp” package:
  - Press CTRL+Super_L to open the menu
  - Type “gftp”
  - Press the “Up” arrow to highlight the “Install gftp” button
  - Press Enter

Did we mention how great package management is yet?

**Synaptic & APT**

If you want to install more than one application or if you’re looking for something which is not in the Software Portal or in the Software Manager, Linux Mint provides two other ways to install software. One is a graphical tool called “Synaptic” and the other is a command line tool called “APT”.

Let’s see how we can install Opera (an alternative to the Firefox Web Browser) with these tools instead:

Open the menu and select “Synaptic Package Manager”.

Page 40 of 50
Click on the “Search” button and type “opera”. Then go through the list of packages and find the one corresponding to the Opera Web Browser. Tick the box and select “Mark for Installation” then click on the “Apply” button.

Now let’s see how we could have installed Opera using the APT command line tool.

Open the menu and select “Terminal”. Then type the following command:

```
apt install opera
```

*Note: Make sure synaptic is closed before using APT. Synaptic is using APT in the background so both can’t run at the same time. The same goes for the Software Manager.*

As you can see APT is extremely easy to use but it’s not graphical. It’s OK. If you’re starting with Linux you probably prefer to deal with a graphical interface (that's why they're there) but as time goes on you’ll prefer things to be fast and efficient and as you can see the fastest way to install Opera is to type “apt install opera”. It can’t be simpler than that.

There is one important difference between the Software Manager and Synaptic/APT though. With Synaptic and APT you basically deal with packages. In our example the Opera application was very simple and was only made of one package which name was also “opera”, but this will not always be the case, and sometimes you might not know what the name of the package is. Sometimes you might not even have access to the packages for a particular application.

The Software Manager is different because it lets you install “applications” by getting the right “packages” for you, not only from the repositories (packages databases) that Synaptic and APT have access to, but also from other places on the Internet.

So you might use the Software Manager for two different reasons:
- Because you’re not used to APT/Synaptic
- Because it can actually install applications you don’t have access to using other tools.

**Remove applications**

**From the Menu**

Removing an application is quite easy in Linux Mint. Simply highlight the application in the menu, right click on it and select “Uninstall”.

The menu finds the packages and dependencies related to the application you selected.

Click “Remove” and the application will be uninstalled.
**Using APT**

Another way to remove applications is by using APT. Again, we’re talking command-line utility here, but see how surprisingly easy this is:

Open the menu and select “Terminal”. Then type the following command:

```
apt remove opera
```

*Note: Make sure synaptic is closed before using APT. Synaptic is using APT in the background so both can’t run at the same time.*

And that’s it. With one single command you’ve removed Opera from your computer.

**Synaptic**

You can also use Synaptic to remove packages... Linux is all about choice so let’s see how to do this.

Open the menu and select “Package Manager”.

Click on the “Search” button and select “opera”. Then go through the list of packages and find the one corresponding to the Opera Web Browser. Tick the box and select “Mark for Removal” then click on the “Apply” button.
Update your system and your applications

If a new version of any package installed on your computer is made available you can upgrade to it. It may be a security update for some component of the operating system, it may be an optimization in one specific library or it may even be a newer version of Firefox. Basically, your system is made of packages and any part of it can be updated by updating some of those packages. This means replacing the current package with a newer version.

There are many ways to do this but only one of them is recommended.

You could use APT to upgrade all your packages with one simple command (“apt upgrade”) but we strongly recommend you don’t do so. The reason is that it doesn’t make any distinctions in selecting which updates to apply and assumes that you want all of them.

Some parts of the system are safe to update and some others aren’t. For instance, by updating your kernel (the part which is responsible among other things for hardware recognition) you might break your sound support, your wireless card support or even some applications (such as VMWare and Virtualbox) which are closely linked to the kernel.

Using the Update Manager

Linux Mint comes with a tool called the Update Manager. It gives more information about updates and lets you define how safe an update must be before you want to apply it. It looks like a shield and sits on the bottom-right corner of your screen.

If you place your mouse pointer on top of it, it will tell you either that your system is up to date or, if it isn't, how many updates are available.
If you click on the lock icon, the Update Manager opens and the first time it will ask you if you want to switch to a local mirror for your updates. Everywhere in the world there are organisations that want to help Linux Mint to spread updates in order to give users the best experience when downloading or updating packages. If you don't want to use a local mirror then you can change this under Edit-Preferences.

The Update Manager shows you the updates that are available. The interface is very easy to use. For each package update you can read the description, the changelog (this is where developers explain their changes when they modify the package), and eventually if Linux Mint assigned warnings or extra information about the updates. You can also see which version is currently installed on your computer and which version is available for you to update to. Also you have a symbol showing if it's a Package update or a Security update.

Finally, you can see the stability level assigned to the package update. Each package update brings improvements or fixes security issues but that doesn’t mean they’re risk-free and can’t introduce new bugs. The stability level is assigned to each package by Linux Mint and gives you an indication of how safe it is for you to apply an update.

Of course you can click on the columns to sort by stability level, status, package name or by version. You can select all updates or unselect all of them by using the “Clear” and “Select All” buttons.
Level 1 and Level 2 updates are risk-free and you should always apply them. Level 3 updates “should be safe” but, although we recommend you take them, make sure you look over them on the list of updates. If you experience a problem with a particular Level 3 update, tell the Linux Mint development team so they can take measures to make that update a Level 4 or a Level 5 so as to warn or even discourage others against applying it.

If you select “Edit” - “Preferences” - “Levels” you should see the screen above. By default the Update Manager tells you about Level 1, 2 and 3 updates. You can decide to make Level 4 and 5 “visible”. This will make more updates appear in the list. If you want to you can even make Level 4 and 5 updates “safe” (although this is not recommended). This will cause them to be selected by default within the Update Manager.

The Update Manager only counts “safe” updates. So when it tells you your system is up to date, it means there are no updates available assigned with a level that you defined as being “safe”.

The Update Manager only shows “visible” updates in the list.

For example, if you made all levels “visible” and only Level 1 and 2 “safe”, you would see a lot of updates in the list, but the Update Manager would probably tell you that your system was up to date.

The “Options” tab gives you a few choices for tweaking the Update Manager.

Under Options the “Include updates which require the installation of new packages or the removal of installed packages” option allows you to define whether the Update Manager should install new dependencies or not. For instance if package A version 1 was installed on your computer and package A version 2 became available, but version 2 had a new dependency on package B which isn’t installed on your computer… what would happen?

If you left this checkbox unchecked, version 2 would not appear as an update in the list of updates.
If you checked this checkbox, it would, and if selected it would install packageB as a dependency.

Be careful with this option as dependency can install new packages on your behalf but it can also sometimes remove packages you already have installed.

The “Auto-Refresh” tab allows you to define how often the Update Manager checks for updates.

In the “Ignored packages” tab you can define packages for which you do not want to receive updates. “?” and “*” wildcard characters are supported.

The “Icons” tab lets you change the icons used by the Update Manager in the system tray.

If you get errors with the Update Manager (“Can’t refresh list of packages” for instance), you can check the logs. Right click on the lock icon in the system tray and select “Information”. The following screen appears:

![Information - Update Manager](image)

In this screen you can see the process ID of the Update Manager, whether it's running with user or root permissions, and the content of its log file.
You can also review the updates that were applied on your system (provided they were applied via the Update Manager) by clicking on “View->History of Updates”.

![History of updates - Update Manager](image)
Tips and Tricks

Are you making the most of your desktop? Do you usually press “CTRL+C” on your keyboard to copy some text? Do you open a text editor to take a quick note? How do you share files with your friends? There are many ways to perform simple tasks, some more efficient than others. This chapter is going to show you a few particularities of Linux, MATE, and the Linux Mint desktop, to make sure you make the most of your system.

Copy and paste with the mouse

Most people are used to clicking on the “Edit” menu or to right clicking on the content they want to copy. In Linux Mint you can do this as well, but most GNU/Linux operating systems also let you copy and paste content from the comfort of your mouse. Here’s how it works: The left button of the mouse copies and the middle button pastes. It’s as simple as that!

Let’s give it a try. Launch LibreOffice Writer or a text editor, or any application of your choice that lets you input text. Now type a few sentences. Select some of the text you just typed with the left button of your mouse. Think you need to click on the “Edit” menu and press “Copy”? No? Bet you’re thinking you would use a combination of keys on your keyboard such as “CTRL+C”. In Linux, it is much simpler. Just by selecting the text, you’ve already copied it. That’s right... that text is now copied to your “mouse buffer” and you don't need to press anything else.

Now click on some other part of the document to move the cursor there and click the middle button of your mouse (or the wheel-click if you have a mouse with a wheel, or both the left and right buttons together if your mouse only has two buttons... everything’s been thought of, apart from those weird Mac mice with only one button). As you can see the text you previously selected has now been pasted.

The more you get used to this the faster you'll get at copying and pasting content. This technique also works on most Unix and GNU/Linux operating systems.

Note: The buffer used by the mouse is not the same as the one used by the MATE desktop. So you can actually copy something with your mouse and copy something else with “CTRL+C” or with the “Edit” menu. Thanks to this you can copy two elements at a time and depending on how you copied them you can paste them with either the middle mouse button or with “CTRL+V” or the “Edit” menu.
Take notes with Tomboy

We all take notes. Whether it's an address given by someone over the phone, an ever-growing TODO list or some particular thing to remember, we're often faced with the situation where we need to take a quick note. Some of us have a lot of written notes around our computers and never seem to find a working pen when the situation arises, others waste time in launching tools that are not suitable for this particular use (LibreOffice Writer for instance is not very handy to take notes) and very few people actually use software dedicated to note-taking. Linux Mint happens to include a dedicated note-taking tool. It is called Tomboy Notes.

Tomboy Notes is a very easy tool to use. By clicking on it you get a list of all your notes. You can create new notes by clicking on “Create New Note”.

A new note opens up. By changing its title you'll also change its name. You can write whatever you want in the note and close it. The content you wrote in your note will always be accessible through Tomboy Notes; You don't need to save anything and you can even reboot or turn off the computer. Again, your note is saved automatically as you're writing it.

If you eventually decide that you no longer need to keep a particular note, you can open that note and click on the “Delete” button.
If you write down the name of another note's title within your note, Tomboy will automatically create a link to that other note and you'll be able to click that link to open the other note.

You can also use different formatting options within your note and use the many features provided by Tomboy Notes (synchronization, search features, export notes to PDF/HTML...etc).

**Conclusion**

There's a lot more to learn about Linux Mint and about Linux in general. This guide was just an overview of some of the aspects related to your desktop. By now you should feel more comfortable with using it and you should have a better understanding of some of its components. Where are you going to go next? Will you learn how to use the terminal? Will you give other desktops a try (KDE, XFCE, etc.)? It's entirely up to you. Remember, Linux is about fun and the community is there to help. Take your time and learn a little bit every day. There's always something new no matter how much you know already.

Enjoy Linux and thank you for choosing Linux Mint.